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WEEK 1: Introduction to Office Suite in Education 

 

In this Unit you will learn about 

 

 The meaning and composition of office suite 

 Understand the organisation of user interface of the various applications making up the 

office suite 

 Become familiar with the components and basic terminologies associated with office suite 

applications.  

 Work with the editing and formatting features of MS word 

 Works with the formatting features of MS word  

 

Introduction to Office Suite 

Office suite is a collection of programs or application that can be used to create documents, 

analyze data, and complete almost any business task. Microsoft Office is a productivity software 

suite that includes a set of software applications, with each one specializing in a particular type of 

output. 

Microsoft Word is a word-processing program used to create, edit and format text-based 

documents, such as letters, memos, newsletters, and reports. Word can be used to add pictures, 

drawings, tables, and other graphical elements to text-based documents such as including memos, 

newsletters, forms, tables, and brochures. 

Microsoft Excel is a spreadsheet program you can use to manipulate, analyze, and chart 

quantitative data. Excel is often used to calculate numerical information. Excel makes it easy to 

organize records, financial transactions, and business information in the form of worksheets. 

Microsoft PowerPoint is a presentation graphics program you can use to develop materials for 

presentations, including slide shows, computer-based presentations, speaker's notes, and audience 

handouts. With PowerPoint, you create dynamic presentations to inform groups and persuade 

audiences. 

Microsoft Publisher is a graphic and multimedia software for designing, and manipulating 

graphics, texts to produce high quality documents. E.g. books, flyers, brochures etc.  

These applications can be integrated into each other. For example; Excel can be used to prepare a 

summary account sheen and then incorporate the worksheet into a Word document. Similarly, Word 

tables and Excel charts can be integrated into a PowerPoint presentation. The choice of which 

software applications to use really depends on the type of output you intend to produce. The table 

below shows the characteristics of three of the application in an office suite package. 
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Identifying Common Interface Components 
 

Each of the applications in the office suite shares a similar user interface.  The user interface is the 

screen display through which users communicate with the software. User Interface is the collection 

of buttons and tools you use to interact with a software program. Word, Excel, PowerPoint and 

Publisher share common interface elements as shown in the figure below. 
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A template is a predesigned file that incorporates formatting elements, such as a theme and layouts, 

and may include content that can be modified. A template is a file that contains predesigned 

formatting and text for common business documents such as letters, business cards, and reports. A 

theme is a collection of design choices that includes colours, fonts, and special effects used to give 

a consistent look to a document, workbook, or presentation.  

 

The title bar identifies the current file name and the application in which you are working. The title 

bar is at the top of the application window. It contains the name of the document and the name of 

the program. The Help icon on the right end of the title bar gives you access to the Office Help 

system. 

The Quick Access Toolbar, located at the top-left corner of any Office application window, 

provides fast access to commonly executed tasks such as saving a file and undoing recent actions. 

The Quick Access toolbar, contain buttons for saving a file, undoing an action, and redoing an 

action.  

 

Ribbon and its Anatomy 

The Ribbon is the command centre of Office applications. It is the long bar located just beneath the 

title bar, containing tabs, groups, and commands. The Ribbon is the band directly below the title 

bar. It contains commands in the form of buttons, icons, lists, galleries, and text boxes. 

Across the top of the Ribbon are several tabs, each of which contains a different set of commands 

for completing a particular type of task. 

Each tab is organized into groups of related commands, such as the Clipboard group, the Font 

group, and the Paragraph group. Each tab is designed to appear much like a tab on a file folder, 

with the active tab highlighted. The File tab is always a darker shade than the other tabs and a 

different colour depending on the application. Clicking the File tab opens the Backstage view. 

Backstage view provide commands and tools to help you work with your files. 

The HOME tab contains commands for performing the most frequently used commands for 

creating a document.  The Ribbon displays several task-oriented groups, with each group containing 

related commands.  

 

The Ribbon Display Options button provides commands for hiding or displaying the Ribbon. 

A group is a subset of a tab that organizes similar tasks together. A command is an instruction you 

give to a computer to complete a task, such as printing a document or saving your changes. A 

command is a button or area within a group that you click to perform tasks. The Ribbon provides 

quick access to common activities such as changing number or text formats or aligning data or text. 
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A dialog box that provides access to more precise, but less frequently used, commands. Other 

Ribbon groups include a Dialog Box Launcher that, when clicked, opens corresponding dialog 

box. Contextual tabs contain groups of commands related to a selected object. The Ribbon is 

modified to include one or more contextual tabs when an object is selected.  

 

The status Bar 

The status bar is located at the bottom of the program window and contains information relative 

To the open file. It includes tools for changing the view of the file and for changing the zoom size 

of onscreen file contents. Contents of the status bar are unique to each specific application. 

Regardless of the application in which you are working, the status bar includes view buttons and a 

Zoom slider. The status bar is located at the bottom of the screen and displays key information, 

such as the current page. View buttons is located at the far right of the status bar. It is used to 

change the view of the document. The Zoom slider, located to the right of the View buttons is used 

to set the magnification level of your document.  

 
The view buttons of the status bar enable you to change the view of an opened file. The Zoom 

slider always displays at the far right side of the status bar.  
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Office Help 

Help is context sensitive in that it displays topics and instructions geared to the specific task you 

are performing. Help is available through a short description that displays when you rest the mouse 

pointer on a command. An Enhanced ScreenTip displays, giving the purpose of the command, 

short descriptive text, and a keyboard shortcut if applicable. 

 

Figure 1: Word Help dialog box icons 

MS Word Widow Elements 

 

 
 

The following list describes Word’s basic features in more detail: 

Commands on the Ribbon enable you to create, modify, and enhance documents. 

When you click a Ribbon tab, you can then select from various commands associated with the tab. 

For example, the Insert tab makes it easy to include objects such as pictures, charts, and screenshots 

in a document, while the Design tab focuses on document formatting and color selections. 

 The title bar indicates the file name of the current document and includes Windows control 

buttons and access to Word Help. It is also the location of the Quick Access Toolbar. 

 The Quick Access Toolbar makes it easy to save a document, and to undo or redo recent 

commands. 

 The status bar keeps you apprised of information such as word and page count, and the 

current position within the document. 
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 View buttons at the right side of the status bar enable you to change the view of a document, 

and dragging the Zoom slider enlarges or reduces the onscreen size of a document. 

 Using the horizontal and vertical scroll bars, you can scroll through a document (although 

doing so does not actually move the insertion point). You will see a scroll bar only if the 

document is long enough and/or wide enough to require scrolling to see additional page 

content. 

Creating and Editing Word Documents 
 

Starting MS Word 

The first step in creating MS Word document is opening or launching the application. There are 

many ways by which MS word can be started. Below are the steps in starting MS word using the 

Start Screen or Start Menu 

 Press or click on the Windows logo key to go to the Start screen 

 Search for and click on word 2013 or the version 

 From the window that opens, select Blank document from the template 

 To begin a blank document, click Blank document  

Word Wrap Feature 

The word wrap feature in MS word automatically pushes words to the next line when you reach the 

right margin. Word wrap is closely associated with another concept: the hard return and soft 

return. A hard return is created when you press Enter at the end of a line or paragraph. A soft 

return is created by 

Word as it wraps text 

from one line to the next. 

. The locations of soft 

returns change 

automatically as text is 

inserted or deleted, or as 

page features or settings, 

such as objects or 

margins, are added or 

changed. Soft returns 

are not considered 

characters and cannot 

be deleted. A hard 

return is actually a 

nonprinting character, called a paragraph mark that can be deleted, if necessary. To display 

nonprinting characters, such as paragraph marks and tabs, click Show/Hide (¶). 

 

 

 

 

 

 

 

 

 

Figure 2 Word wrap hard and soft wrap 
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Reuse Text 

There are occasions when one will like to reuse text from a previously created document because 

the wording fits well in a current document on which one is working on. Below is the steps in 

reusing text from previously created document. With the insertion point positioned where the 

inserted text is to be placed,  

 Click the INSERT tab. 

 Click the Object arrow  

 Click Text from File. 

 Navigate to the location of the saved document and double-click the file name 

 
 

Save a Document 

Saving a document makes it possible for you to access it later for editing, sharing, or printing. 

To make that possible, Word documents can be saved to local storage, such as a flash drive, hard 

drive, or local network location like OneDrive and Google drive. It is always a good idea, however, 

to save a document in several places so that you always have a backup copy.   

To save a document to local storage, such as a flash drive, hard drive, or local network location,  

 click Computer and c 

 click Browse to navigate to the desired location 

 Provide a file name and either accept the default file type (Word Document:  .doc or .docx) 

or click the Save as type arrow and select another format. 

Move around a Document and edit a Document  

The insertion point indicates where the text you type will be inserted. It is important to be aware of 

the location of the insertion point and to know how to move it so you can control where text is 

typed.  

 When you reposition the insertion point within existing text in a document and then type 

text, the text is inserted between pieces of existing text. 

 If the document contains more text than will display onscreen at a time, the horizontal or 

vertical scroll arrows is clicked (or drag a scroll bar) to view different parts of the document. 

 When the desired text is shown onscreen, click to position the insertion point and continue 

editing the document. 

 Be reminded that using the scroll bar or scroll arrows to move the display does not reposition 

the insertion point. It merely lets you see different parts of the document, leaving the 

insertion point where it was last positioned. 

  

Review Word Usage in a Document 

It is important to create a document that is free of typographical and grammatical errors. Word 

provides tools to help you make sure your documents are free of spelling and grammatical errors. 

The program identifies possible misspelled words by comparing each word to its built-in dictionary, 

then underlines any words that are not in its dictionary with red wavy lines. These words are 
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considered to be misspelled. Word identifies possible grammatical errors such as passive voice by 

underlining them with green wavy lines. In some cases a possible grammatical mistake or word 

usage error is underlined in blue These tools are provided on the Review tab to simplify the tasks 

of reviewing a document for errors, identifying proper wording, and defining unfamiliar words. 

These tools are spelling and grammar checker, define. Thesaurus and word count. 

 

To correct possible spelling, grammatical, or word usage errors in a document, you can right-click 

an underlined error and select an option from a shortcut menu. 

 

Correcting each error by right-clicking can become time-consuming, especially if the mistakes are 

many. In that case, Word can check an entire document, pausing at each identified error so that 

you can determine whether to correct or ignore the problem. To check an entire document, click 

the Review tab and click Spelling & Grammar in the Proofing group.  
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Editing 

Editing involves copying, pasting, moving and deleting text and other objects in a document.   
You can edit, or modify, the text in a Word document in several ways. 

Delete 

 To delete individual letters, first  

 Click to the right of the unwanted letters to set the insertion point  

 press [Backspace], or 

 click to the left of the letters and  

 then press [Delete] 

 To delete several words or paragraphs, you must first; 

 select, or highlight, the unwanted text, then 

 press [Delete] 

 To select text, drag the I-beam mouse pointer across the text, then release the mouse button 

To edit text, you need to move the insertion point around the document. You can do this by pointing 

and clicking or by using the keyboard. 

 To copy and paste text, you first need to select the text you want to copy. Below are other useful 

ways of selecting texts. 

 

 

Copying Text 

When editing a document, also involves copying text from one place to another. Copying leaves the 

text in its original location, and pasting moves a duplicate of it to the location you specify.  

 To use the Office Clipboard, you need to open the Clipboard task pane.  

 You can also duplicate text using a technique called drag and drop, where you 

o  select the text you want to copy,  

o press and hold [Ctrl], and then  

o use the mouse to drag a copy of the selected text to a new location 

Moving Text 

Moving text removes it from its original location and places it in a new location that you specify. 

You can move text to a new location using the Cut and Paste commands.  

The Cut command removes selected text from your document and places it on the Windows 

Clipboard as well as the Office Clipboard if activated. 

 To place the cut text in another location, you can either  

o click the Paste button on the HOME tab of the Ribbon or  

o click the item in the Clipboard task pane 

You can also move text by selecting it and then dragging it to a new location.  
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Figure 3: Copying and pasting text 

NOTE: 

Items that you move using the drag-and­ drop method do not get copied to the Windows or Office 

Clipboard. 

 

Find and Replace Text 
The Find command [Ctrl +F] find text or other content in a document  

The Replace command [Ctrl +H] helps you quickly and easily substitute a new word or phrase for 

one or more occurrences of a particular word or phrase in a document. It finds text or content you 

will like to change and replaces it with a new word or phrase. 

 
Figure 4: Finding and replacing text using the Navigation Pane 
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Formatting  
Change Font and Font Size  

Choosing an appropriate font is an important part of formatting a document. The fonts sets the 

tone of your communication. You can use either the HOME tab or the Mini toolbar to change the 

font and font size. You can change font and font size before you begin typing, or you can select 

existing text and apply changes to it.  

 
Figure 5:  Changing the font size of selected text using the Font Size list 

Change Font Color, Style, and Effects 

Sometimes you want to emphasize certain words, phrases, or lines of text. To do this, you can use 

font styles, which are font attributes such as bold (darker type), Italic (slanted type), and underline. 

 

You can also make certain words stand out by changing their color, or you can apply font effects to 

selected text.  

 

Font effects are special enhancements such as shadow (Shadow looks like this) or strikethrough 

(strikethrough looks like this) that you can apply to selected text. 

 

The buttons in the Font group on the HOME tab can be used to apply font effects and formatting 

to selected text. To save time, the Format Painter button can also be used to copy the formatting of 

selected text to other text.   
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Figure 6: Font Color list with green color selected 

 
Figure 7:  Applying a text effect 

  
Figure 8:  Bold and italic formatting applied to text 
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Change Alignment and Line Spacing  
The amount of space between the edge of the page and your document text is called the margin. 

The alignment, or position of text within a document's margins can be changed, using the alignment 

buttons in the Paragraph group on the HOME tab. titles are often centered, headings left-aligned, 

and paragraphs Justified. 

The spacing between lines can be adjusted using the Line and Paragraph Spacing button in the 

Paragraph group on the HOME tab In Word, a paragraph is any text that ends with a paragraph 

mark ( ) so it can be as short as a one-word title or as long as you like. A paragraph mark is 

inserted anytime you press [Enter]; this is also called a hard return.  

 
Figure 9:  Center-aligned text 

 
Figure 10: Paragraph with justified alignment and line spacing set to 1.0 
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Change Margin Settings 
A margin is the area of blank space that displays to the left, right, top, and bottom of a document, 

between the text and the edge of the page. Although a 1" margin all around the document is the 

normal setting, you can easily adjust one or more margins for a particular document. By default, 

Word sets page margins at 1" from the top, bottom, left, and right sides of the page. Word also 

provides a number of additional preset margin settings that you can easily view and choose by 

clicking the Margins button on the PAGE LAYOUT tab. If you do not like any of the preset margin 

settings, you can specify custom settings by using the Margins tab of the Page Setup dialog box. 

When you change the margins, Word automatically adjusts line wrapping and repaginates or 

renumbers the pages of the document. You can change margins in a couple of ways: 

 Click the PAGE LAYOUT tab  

 click Margins in the Page Setup group.  

 Select from one of the predefined margin settings  

 or click Custom Margins to adjust each margin (left, right, top, and bottom) individually 

 
Figure 11:  Boat Kits Fact Sheet with Narrow margins setting applied 

 Click the FILE tab and click Print.  

 Click Normal Margins (or the previous margin setting) to change one or more margins 

 
Figure 12: Margins tab of Page Setup dialog box 

 



16 

 

Set Tabs  
A tab is a set position where text following a tab character aligns. It is a marker that specifies a 

position for aligning text. When the [Tab] key is pressed, Word inserts a tab character- a right-

facing arrow-to indicate the presence of a tab. The ruler makes it easy to set tab stops (locations 

the insertion point moves to when you press [Tab]) and to immediately see how they affect your 

document. By default, Word sets left-aligned tab stops every 1 /2". Any tab stop you add to the 

ruler will appear as a tab icon on the ruler and will override the default tab stop settings to the left 

of it. By default, new tab stops that you set on the ruler are left-aligned tab stops and appear as a 

 on the ruler. The tab selector on the ruler is used to align text differently, such as to the right or 

center of a tab stop.  

 

Figure 13: Selected text with tabs inserted 

  

 

 
Figure 14:  Text arranged in columns with left and right tabs set 
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     Figure 15: Tab Markers 

 

Set Indents  

An indent is a set amount of space between the edge of a paragraph and the right or left margin. 

Different types of indents are appropriate for different situations. A first line indent indents the first 

line of text in a paragraph. A left indent indents the left edge of an entire paragraph. A right indent 

indents the right edge of an entire paragraph. A hanging indent is an indent where the first line of 

a paragraph is aligned flush left with the margin and all lines below it are indented. You can set 

indents using the sliding markers on the ruler. The table below describes these markers.  

 
Figure 16: Ruler markers used for setting indents 

 
Figure 17:  Setting a hanging indent 
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Figure 18: Paragraphs formatted with left indent 

 

Add Bulleted and Numbered Lists 
Word provides many tools for organizing your text into a more orderly format. You can easily 

organize groups of related paragraphs into bulleted or numbered lists. You already learned how to 

create a bulleted list using the Bullets button on the Mini toolbar. The Bullets button is also available 

on the HOME tab. Use a numbered (ordered) list when you want to present items in a particular 

sequence, and use a bulleted (unordered) list when the items are of equal importance. Use a 

numbered list if the list is a sequence of steps There are many bullet and numbering styles to choose 

from when using the Bullets list and Numbering list on the HOME tab, or you can create a custom 

style. 

 
Figure 19: Bullet library 
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Figure 20: Boat Kit fact sheet with bulleted and numbered lists 

Apply Styles 

A style is a set of predefined formatting attributes. A style set is a group of professionally 

coordinated styles that look great together; applying a different style set changes all the styles in the 

document to a different overall look. A style is a named collection of formatting characteristics. 

Styles automate the formatting process and provide a consistent appearance to a document. Some 

styles are considered either character or paragraph styles. A character style formats one or more 

selected characters within a paragraph, often applying font formats found in the Font group on the 

Home tab. A paragraph style changes the entire paragraph in which the insertion point is located, 

or changes multiple selected paragraphs. A style set is a combination of title, heading, and paragraph 

styles. 

 
Figure 21:  Styles gallery 

To modify a style: 

 Click the Styles Dialog Box Launcher. 

 Point to a style in the Styles pane and click the arrow on the right. 

 Click Modify. The Modify Style dialog box displays. 

 Change any font and paragraph formatting or click Format for even more choices. 

 Click Add to the Styles gallery if the style is one you are likely to use often. 
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 Indicate whether the style should be available only in the current document, or in new 

documents based on the current template. 

 Click OK 

 

Insert a Header or Footer 
Headers and footers can give a professional appearance to a document. A header consists of one 

or more lines at the top of each page. A header is text that appears in the top margin of a page.  A 

footer displays at the bottom of each page. Headers and footers usually repeat from page to page. 

In addition to page numbers, headers and footers often contain such information as the date, the 

document author's name, or the file name. Headers and footers can be added using the Header and 

Footer buttons on the INSERT tab. 

One advantage of using headers and footers is that you have to specify the content only once, after 

which it displays automatically on all pages. 

 

To insert a header or footer,  

 click the Insert tab and  

 click Header (or Footer) in the Header & Footer group  

 Select from a gallery of predefined header or footer styles or click 

Edit Header (or Edit Footer), as shown in to create an unformatted header or footer.  

After typing a header or footer, click Close Header and Footer to leave the header and footer area 

and return to the document 

 
Figure 22: Header with name and page number 

 

Add Borders and Shading 
A border is a line that surrounds a paragraph, a page, a table, or an image, similar to how a picture 

frame surrounds a photograph or piece of art. A border can also display at the top, bottom, left, or 

right of a selection. Shading is a background color that appears behind text in a paragraph, a page, 

or a table. You can add visual interest to an entire document or set a block of text apart from the 

rest of the page by adding borders and background shading to words, paragraphs, graphics, or entire 

pages. To add these elements to an entire page, you can use the Page Color and Page Borders buttons 

in the Page Background group on the PAGE LAYOUT tab; to add them to selected text, it is 

easiest to use the Shading and Borders buttons on the HOM E tab. 

The Page Border tab in the Borders and Shading dialog box provides controls that you use to place 

a decorative border around one or more selected pages. To apply shading to one or more selected 

paragraphs, click the Shading arrow in the  

Paragraph group on the Home tab. 
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Figure 23: Borders tab of Borders and Shading dialog box 

 

Change page Orientation 

A document displayed in portrait orientation is taller than it is wide, whereas a document shown in 

landscape is wider than it is tall. Most certificates are designed in landscape orientation; letters and 

memos are typically presented in portrait orientation. You can change page orientation in several 

ways: 

 Click Orientation on the PAGE LAYOUT tab to select either Portrait or Landscape. 

 Click Margins on the PAGE LAYOUT tab and click Custom Margins to display the Page 

Setup dialog box. From there, select either Portrait or Landscape. 

 Click the FILE tab, click Print, and then click Portrait Orientation (or Landscape 

Orientation if the document is in landscape orientation). Select either Portrait Orientation or 

Landscape Orientation. 

 
Figure 24: Selecting Portrait and Landscape 

Section and Page Break 
There are two major breaks that can be inserted into Word Document. These are Page break and 

Section break. Page break marks the point at which one page ends and the other page begins. There 

are two forms namely column and text wrapping. In a column break, any text to the right of the 
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cursor where the break is inserted is forced into the next column. A text wrapping break moves 

any text to the right of the cursor to the next line. 

A section break is a marker that divides a document into sections. Word stores the formatting 

characteristics of each section within the section break at the end of a section. 

 
 

To place a section break in a document: 

1. Click at the location where the section break should occur. 

2. Click the PAGE LAYOUT tab. Click Breaks in the Page Setup group. 

3. Select a section break type. If nonprinting characters display, you will see a section break 
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Format text into columns 

Columns format a document or section of a document into side-

by-side vertical blocks in which the text flows down the first 

column and continues at the top of the next column. To format text 

into columns,  

 click the Page Layout tab  

 click Columns in the Page Setup group 

 Specify the number of columns or select More Columns to 

display the Columns dialog box. 

 

 

Create a Table 

A table is a grid of rows and columns. The intersection of a row and column is called a cell. Cells 

can contain either text or graphics. You can insert a table using the Table button on the INSERT 

tab. When you create a table, you specify the number of rows and columns; you can also add and 

delete rows and columns as you modify a table. You can use tabs to organize text into rows and 

columns, but working with tables is often easier. 

 

Figure 25: Table with all information entered 

 

After you create a table, you might need to add more information or delete existing information. To 

accommodate the new information, you can n add rows to the top, bottom, or middle of a table. You 

can add columns anywhere in a table, too. You can use commands on the TABLE TOOLS 

LAYOUT tab to add or delete columns and rows. 

A table style is a predefined set of formatting attributes, such as shading, fonts, and border color 

that specify how a table looks. 

 

Word provides several predesigned table styles that contain borders, shading, font sizes, and other 

attributes that enhance the readability of a document. Use a table style when: 

 You want to create a color-coordinated, professional document. 

 You are coordinating a table with elements of Word, Excel, or PowerPoint files, so that the 

table can be shared among the Office applications. 

 You do not have time to design your own custom borders and shading. 
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Reading assignment 1 

Discuss the pedagogical implications of Office package for teaching and learning. 
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